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License Agreement 
 
 

THIS IS AN IMPORTANT LEGAL AGREEMENT – 
PLEASE READ CAREFULLY 
 
SoftHill Ltd. has licensed you to use the software product described below on the 
following terms: 
 
1. BriLAN software. 

 
The software product includes all computer software, printed materials, 
electronic documentation and online services. 
(a) The software product includes any updates issued from time to time. 
(b) The software product does not include any software that is provided and 

associated with a separate end-user license any such software is 
licensed to you on the terms  of that separate end-user license. 

 
2. You agree to be bound by the terms of this agreement by installing, copying, 

downloading, accessing or otherwise using this software product. 
 
3. If you do not agree, do not install or otherwise use this software product and 

return it to the place of purchase for a refund. 
 
4. This software is protected by Canadian and International copyright law. 
 
5. This software product may be copied for archive purposes only. 
 
6. Others may only use this software so long as it is used by one CPU at a time. 
 
7. Use of this software product on more than one CPU or making it or copies 

available to more than one CPU will breach copyright law. 
 
8. You may transfer your rights to the software product by giving all of the 

software and documents, including the license, to another person.  You must 
not ise this software product or any copy after you have transferred it to 
another person. 
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9. You may only copy or transfer this software product in accordance with the 
above terms.  You must not rent, lease, lend, modify, translate, sub-license, 
time-share, electronically transmit or receive, or decompile or reverse 
engineer this software product or the support documentation or media. 

 
If you do not agree to these terms do not use this software product 
and return the software product including all supporting documents 
in their original packaging to the place of purchase for a refund. 

   
LIMITED WARRANTY 
  
SoftHill warrants that the BriLAN Software Product  will perform substantially in 
accordance with the accompanying written materials for a period of ninety (90) 
days from the date of receipt. 
 
If an implied warranty or condition is created by your state/jurisdiction and federal 
or state/provincial law prohibits disclaimer of it, you also have an implied 
warranty or condition.  But only as to defects discovered during the period of this 
limited warranty (ninety (90)  days) As to any defects discovered.  As to any 
defects discovered after ninety (90) days, there is no warranty or condition of any 
kind. Some states/jurisdictions do not allow limitations on duration of an implied 
warranty, so the above limitation may not apply to you. 
 
Any supplements or updates to the BriLAN Software Product, including without 
limitation, any (if any) service packs or hot fixes provided to you after the 
expiration of ninety (90) day Limited Warranty period are not covered by any 
warranty or condition, express or implied, or statutory. 
 
LIMITATION ON REMEDIES; NO CONSEQUENTIAL OR OTHER 
DAMAGES.  
Your exclusive remedy for any breach of this Limited Warranty is as follows: 
Except for any refund elected by SoftHill, you are not entitled to any damages, 
including, but not limited to consequential damages, if the BriLAN Software 
Product does not meet SoftHill’s Limited Warranty, and, to the maximum  extent 
allowed by applicable law, even if any remedy fails of its essential purpose.  The 
terms “Exclusion of Incidental, Consequential and Certain Other Damages” below 
are also incorporated into this Limited Warranty.  Some states/jurisdictions do not 
allow  the exclusion or limitation of incidental or consequential damages, so the 
above limitation or exclusion may not apply to you.  This Limited Warranty gives 
you specific legal rights.  You may have others which vary from state/jurisdiction 
to state/jurisdiction. 
 
YOUR EXCLUSIVE REMEDY.   
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SoftHill’s and its suppliers’ entire liability and your exclusive remedy shall be at 
SoftHillt’s option from time to time: 
(i) return of the price paid (if any) for the SOFTWARE PRODUCT, or 
(ii) repair or replacement of, the BriLAN Software Product that does not meet 

this Limited Warranty and that is returned to SoftHill with a copy of your 
receipt.   

You will receive the remedy elected by SoftHill without charge, except that you 
are responsible for any expenses that you may incur (e.g. cost of shipping BriLAN 
Software Product to SoftHill).  
Failure of the BriLAN Software Product as a result of accident, abuse, 
misapplication, abnormal use or a virus this voids this Limited Warranty.   
Any replacement BriLAN Software Product will be warranted for the remainder of 
the  original warranty period or thirty (30) days, whichever is longer.   
Neither these remedies nor any product support services offered by SoftHill are 
available  without proof of purchase from an authorised source.   
To exercise your remedy, contact: SoftHill, Attention: Support at the address 
specified above, or the SoftHill agent servicing your country. 
 
DISCLAIMER OF WARRANTIES.   
The only express warranty made to you is the limited warranty that appears above 
and is provided in lieu of any other express warranties (if any) created by any 
documentation or packaging.  Except for the limited warranty and to the maximum 
extent permitted by applicable law, SoftHill and its suppliers provide the BriLAN 
Software Product and Support Services (if any) as is and with all faults, and 
hereby disclaim all other warranties and conditions, either express, implied or 
statutory, including, but not limited to, any (if any) implied warranties or 
conditions of merchantability, of fitness for a particular purpose, of lack of viruses, 
of accuracy or completeness of responses, of results, and of lack of negligence or 
lack of workmanlike effort, all with regard to the BriLAN Software Product, and 
the provision or failure to provide Support Services.  
 
EXCLUSION OF INCIDENTAL, CONSEQUENTIAL AND CERTAIN 
OTHER DAMAGES.  
To the maximum extent permitted by applicable law, in no event shall SoftHill or 
its suppliers be liable for any special, incidental, indirect, or consequential 
damages whatsoever (including, but not limited to damages for loss of profits or 
confidential information, for loss of privacy, for business interruption, for personal 
injury, for failing to meet any duty including of good faith or of reasonable care, 
for negligence, and for any other pecuniary or other loss whatsoever) arising out of 
or in any way related to provide Support Services, or otherwise under or in 
connection with any provision of this Agreement, even in the event of the fault, 
tort (including negligence), strict liability, breach of contract or breach of warranty 
of SoftHill or any supplier, and even if SoftHill or any supplier has been advised 
of the possibility of such damages. 
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LIMITATIONS OF LIABILITY AND REMEDIES.   
The entire liability of SoftHill and any of its suppliers under any provision of this 
Agreement and your exclusive remedy for all of the foregoing (except for any 
remedy of repair or replacement elected by SoftHill with respect to any breach of 
the Limited Warranty) shall be limited to the greater of the amount actually paid 
by you for the SOFTWARE PRODUCT or U.S.$5.00, notwithstanding any 
damages that you might incur for any reason whatsoever (including, without 
limitation, all damages referred referenced above and all director general 
damages).  The foregoing limitations, exclusions and disclaimers described above 
shall apply to the maximum extent permitted by applicable law, even if any 
remedy fails its essential purpose. 
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PREFACEPREFACEPREFACEPREFACE    

� 

This Installation Guide provides instructions on 
how to install and configure devices using 
SoftHill’s BriLAN Network Operating System. 

Dear Customer,  
Thank you for purchasing BriLAN -  the most effective last-mile revolutionary One-
Box solution in the entire fixed wireless broadband industry.  
 
Through a combination of BriLAN Network Operating System (BriLAN NOS) and 
standard “off the shelf” components based on Ix86 architecture, you can build a 
multifunctional network device.  BriLAN is designed for wired (Ethernet, 
FastEthernet) or wireless transmission (using unlicensed 2.4 GHz ISM and 5.8 GHz 
ISM bands) of data and analog information as well as digital voice. BriLAN enables 
high-performance and cost effective LAN-to-LAN, LAN-to-WAN and PBX-to-
PBX or Phone-to-Phone connectivity. 
 
The BriLAN package contains two main components: network operation system 
(BriLAN NOS) and the management software (BriLAN NMS).  
BriLAN NOS comes in two versions: 
� BriLAN PRO –a software package for handling different types of network data, 

combining multiple functions: Bridge, Multiplexer, Router, Hub, Switch, and 
Active Repeater.  

� BriLAN VOX –a software package that interconnects the world of 
telecommunications with the world of information technologies.  It provides all 
the data communication functionality of BriLAN PRO but also includes Voice 
communication features.  

BriLAN NMS – is a sophisticated management system for managing BriLAN 
controlled devices. It combines a complete set of network performance, planning and 
analysis tools in a single program running under Windows 95/98/NT/2000/XP OS. 
 
To learn more about networking using the Device, you can also visit our web site at: 
www.softhill.com or www.brilan.com. 
 

http://www.softhill.com/
http://www.brilan.com/
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THE BRILAN NMS WINDOTHE BRILAN NMS WINDOTHE BRILAN NMS WINDOTHE BRILAN NMS WINDOWWWW    

� 

This chapter provides information on the Main 
Menu of BriLAN NMS. 

 
When you start the BriLAN NMS application the BriLAN NMS main program 
window is displayed. 
 

The BriLAN NMS window is 
divided into two main panes. You 
can find the short list of Devices 
available in your BriLAN 
Network in the left BriLAN 
Network Activity pane. The right 
pane holds navigating tabs for 
quick access to your devices, 
statistics or network events. 

 
The main menu of the BriLAN NMS program window contains commands for 
configuring, tuning and managing your Devices. 
 

 � File menu – The File menu collects 
commands to provide basic 
configuration of your Devices. 

� Device List menu – The Device List 
menu contains commands to add and 
remove Devices from the list of 
managed Devices. 

� Network Admin menu – The Network 
Admin menu contains commands to 
undertake common administration tasks 
with your BriLAN Network. 

� Network Map menu – The Network 
Map menu collects commands to 
customize the BriLAN Network Map. 
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� Help menu – The Help menu provides 
on-line assistance to specific queries. 

 
The BriLAN Network Activity pane contains the list of your Devices added to the 
BriLAN Network. 
 

 

You can easily determine the status of your Devices listed 
in the BriLAN Network Activity Pane using the color-code 
LED diodes.  
Green – The services running on your Device are in 100 
per cent state. 
Yellow – Some problems were experienced with one or 
more services, ports or configuration of your Device. 
Red – One or more services, ports or configuration of 
your Device experiencing critical errors without possibility 
of automatic recovery. 
Gray – There is no access to your Device for serious 
network connectivity reasons (no route or Device is 
down).   

 
The navigation pane of the BriLAN NMS window contains tabs for quick access to 
your Device List, Network Map, and Network Events. 
 

 
� Device List – The Device List tab contains the list of basic information about 

the status, and loading of services currently running on your Devices connected 
to the BriLAN network. 

� Network Map – The Network Map tab contains your Devices organized by 
connections into a network map. 

� Network Events – The Network Events tab contains the logs of registered 
network events on your Devices. 

The Device List tabThe Device List tabThe Device List tabThe Device List tab    

In the details pane of Device List of the BriLAN NMS you will find information on 
the status and loading of currently running services on your Devices.  
Use the following buttons for easier navigation in your Device List: 
 

� Device Name – The Device Name is a unique text variable of a particular 
Device with maximum length of 20 characters. 
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� Device IP Addr. – The Device IP Addr. is a unique IP address reserved for a 
particular Device. 

� Status – The Status variable informs you about the overall operational status of a 
particular Device. 

� Utilization – The Utilization variable displays the CPU performance graphs of a 
particular Device. 

� TimeSync. Master – The TimeSync. Master variable contains IP address of the 
Time Synchronization Master computer, which is required for synchronization 
of time and date for management purposes.  

� Running Tasks - The Running Tasks variable displays one-character codes of 
the currently active services on a particular Device: (B – for bridging, R – for 
routing, S – for traffic shaping, BSP-broadcast storm protection) 

� S/N – The S/N variable displays the serial number of BriLAN NOS running on 
a particular Device. 

� SW ver. – The SW ver. variable displays the version of BriLAN NOS running on 
a particular Device. 

� UpTime – The UpTime variable displays the elapsed time from the last restart 
of a selected Device. 

The Device List popup menuThe Device List popup menuThe Device List popup menuThe Device List popup menu    

To access the Device properties listed in the details pane of the Device List tab, right 
click the record of a selected Device. 
 

� Expanded View – Each Device, listed on your 
BriLAN Network can be simultaneously displayed 
in details in it's own Expanded View window. 

� Device Events –  Each Device records actions, 
events, warnings related to it’s operational status or 
accessibility of your BriLAN Network. 

� Remove Device form List – Use the Remove 
Device form List command to remove the entry of 
a selected Device from the Device List. 

The Network Map tabThe Network Map tabThe Network Map tabThe Network Map tab    

The Network Map tab contains your Devices organized by connections into a 
network map. You can easily determine the ways  your Devices are connected. This 
Network Map is generated automatically when you add a Device to your BriLAN 
Network. 
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The Device icons are color-
coded: 

Green – The services 
running on your Device are 
in 100 per cent operational 
state. 
Yellow – Some problems 
were experienced with one 
or more services, ports or 
configuration of your 
Device. 
Red – One or more 
services, ports or 
configuration of your 
Device is experiencing 
critical errors without 
possibility of automatic 
recovery. 
Gray – There is no access 
to your Device for serious 
network connectivity 
reasons (no route or Device 
is down). 

The Network EventsThe Network EventsThe Network EventsThe Network Events tab tab tab tab    

The Network Events tab contains records about the actions, events and warnings 
related to the operational status of your Devices or accessibility of your BriLAN 
Network. 

You can easily determine 
the operation status of  
your BriLAN Network 
using color-coded event 
logs: 

Blue –  This log record only 
contains data of an 
informative nature?  Not sure 
what you are trying to say here 
Green – This log record 
informs you about the 100 
per cent operational state of 
a service, port or 
configuration running on 
your Device. 
Yellow – This log record 



  

 

    http:\\www.brilan.com, http:\\www.softhill.com 

 

15 

informs you about some 
problems experienced with 
one or more services, ports 
or configuration of your 
Device. 
Red – This log record 
informs you about critical 
problems (non-recoverable) 
experienced with one or 
more services, ports or 
configuration of your 
Device. 

File menuFile menuFile menuFile menu    

The File menu of the BriLAN NMS program window contains commands for 
basically configuring your Devices using the Serial Line Console. 

Device menuDevice menuDevice menuDevice menu    

The Device menu of the BriLAN NMS program window contains commands for 
adding and removing your Devices in the BriLAN Network. 

Network Admin menu Network Admin menu Network Admin menu Network Admin menu     

The Network Admin menu of the BriLAN NMS program window contains  
commands to provide common administration tasks with your BriLAN Network. 

Network Map menu Network Map menu Network Map menu Network Map menu     

The Network Map menu of the BriLAN NMS program window contains commands 
to customize the BriLAN Network Map. 

Help MenuHelp MenuHelp MenuHelp Menu    

The Help menu of the BriLAN NMS program window contains commands for 
searching and browsing BriLAN on-line help file. 
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THE FILE MENUTHE FILE MENUTHE FILE MENUTHE FILE MENU    

� 

This chapter provides information on the File 
menu of BriLAN NMS. 

The File menu of the BriLAN NMS program window contains commands for 
working with your Devices using Serial Line Console. 
You can access the following menu items in the File menu of the BriLAN NMS 
program window: 
 

 

� Serial Line Console 
� Exit 

Serial Line ConsoleSerial Line ConsoleSerial Line ConsoleSerial Line Console    

To open the Serial Line Console window, click the Serial Line Console 
command.  
The Serial Line Console is used for setting up initial operating parameters of the 
BriLAN NOS software. The basic set up of BriLAN NOS requires a temporary 
serial cable connection between BriLAN NMS and the Device.  
For more information refer to the appropriate chapter in this Guide or refer to the 
BriLAN Installation Guide. 

ExitExitExitExit    

Click this command to quit the BriLAN NMS application. 
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THE DEVICE LIST MENUTHE DEVICE LIST MENUTHE DEVICE LIST MENUTHE DEVICE LIST MENU    

� 

This chapter provides information on the 
Device List menu of BriLAN NMS. 

The Device List menu of the BriLAN NMS program window contains commands 
for adding, removing and managing Devices from your BriLAN Network. 
You can access the following menu items in the Device List menu of the BriLAN 
NMS program window: 
 

� Add Device to Map 
� Remove Device from Map 

Add Device to ListAdd Device to ListAdd Device to ListAdd Device to List    

To add a new Device to the BriLAN Network, click the Add Device to List 
command. 
Your BriLAN Network contains the Devices you may access. These Devices are 
available in Device List and Network Map. The Device List contains the list of 
basic information about the status, and loading of currently running services on your 
Devices connected to the BriLAN Network. The Network Map contains your 
Devices organized by connections into a network map. You can select the Device to 
add to your Network Map by entering IP address of your Device in the Add 
Device dialog.  
Each Device listed on your BriLAN Network can be simultaneously displayed in 
detail in it's own Expanded View window (see the Expanded View section). 

Remove Device from ListRemove Device from ListRemove Device from ListRemove Device from List    

To remove a selected Device from BriLAN Network, click the Remove Device 
from List command. 
Your BriLAN Network contains the Devices you may access. These Devices are 
available in the Device List and in the Network Map.  The Device List contains 
the list of basic information about the status, and loading of currently running 
services on your Devices connected to the BriLAN Network. The Network Map 
contains your Devices organized by connections into a network map.  
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Each Device, listed on your BriLAN Network, can be simultaneously displayed in 
detail in it's own Expanded View window (see the Expanded View section). 
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THE NETWORK ATHE NETWORK ATHE NETWORK ATHE NETWORK ADMIN MENUDMIN MENUDMIN MENUDMIN MENU    

� 

This chapter provides information on the 
Network Admin menu of BriLAN NMS. 

The Network Admin menu of the BriLAN NMS program window contains 
commands for synchronizing the BriLAN NOS time, viewing network events and 
upgrading BriLAN NOS on the Devices. 
You can access the following menu items in the Network Admin menu of the 
BriLAN NMS program window: 
 

� Time Synchronization Master 
� Synchronize Network Time 
� Network Events 
� System Upgrade 

Time Synchronization MasterTime Synchronization MasterTime Synchronization MasterTime Synchronization Master    

Date and time of your Devices connected to the BriLAN Network should be 
synchronized with the local system date and time on the computer running the 
BriLAN NMS program. The time synchronization procedure works in automatic and  
manual mode. To use the automatic time synchronization method, one of your 
computers running BriLAN NMS should be defined as Time Synchronization Master 
(TSM). 

To define the computer as Time 
Synchronization Master for your BriLAN 
Network enter a valid IP address for the 
PC running BriLAN NMS. 
You can check the current assignment of 
TSM of your BriLAN Network in the 
Time Synchronization Master window.
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Synchronize Network TimeSynchronize Network TimeSynchronize Network TimeSynchronize Network Time    

Date and time of your Devices connected to the BriLAN Network should be 
synchronized with the local system date and time on the computer running BriLAN 
NMS program. To synchronize time and date on your Devices you should be logged 
onto the Device with  system administrator rights (with opened SysAdmin level). 
 

There are two methods to keep your 
Devices synchronized: 
Automatic Synchronization – TSM 
broadcasts time synchronization packets 
in your BriLAN Network (1 packet per 
hour), which are accepted by the Devices 
with selected Automatic Synchronization 
method. 
Manual synchronization – Requests 
immediate single-shot time 
synchronization for your Devices with 
the TSM. 
Current Time – The Current Time 
variable informs you abut the local system 
time. 

Network EventsNetwork EventsNetwork EventsNetwork Events    

Devices connected to your BriLAN Network record actions, accessibility and 
warnings related to operational status. 
To preview events registered in your BriLAN Network, first select month, year and 
date in the upper pane and than click Open button to display network events for a 
selected day. The Network Events window contains logged event records on all 
Devices in your BriLAN Network for a selected date. You can sort listed event 
records by clicking on the column headers. 
 

� Severity – The Severity variable is 
used for grouping events by 
authority categories. 

� Received at – The Received at 
variable contains time and date 
information, when the event was 
received. 

� Sent by – The Sent by variable 
contains the Device name, which 
sent the event. 

� Event Message – The Event 
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Message variable contains detailed 
description of the given event 

System UpgradeSystem UpgradeSystem UpgradeSystem Upgrade    

The System Upgrade command of the Network Admin menu is used for remote 
upgrades of BriLAN NOS on your Devices connected to the BriLAN Network.  

� The BriLAN Image File command is used for 
remote upgrade of a previous version of BriLAN 
Image File over the network from BriLAN NMS to 
all Devices. 

� The BriLAN Configuration Utility command is used 
for remote upgrade of a previous version of BriLAN 
Configuration Utility over the network from BriLAN 
NMS to all Devices. 

 
The Enter file name box is used for entering the name of an appropriate BriLAN 
NOS file for upgrade. 
 

 

Use the Browse button to select an 
appropriate BriLAN NOS file for upgrade in 
the Open  dialog. 
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THE NETWORK MAP MENUTHE NETWORK MAP MENUTHE NETWORK MAP MENUTHE NETWORK MAP MENU    

� 

This chapter provides information on the 
Network Map menu of BriLAN NMS. 

The Network Map menu of the BriLAN NMS program window contains 
commands to customize the appearance of the Network Map. 
You can access the following menu items in the Network Map menu of the 
BriLAN NMS program window: 
 

 

� Show Port Labels – The Show Port Labels 
command changes the visibility of port labeling 
information. 

� Wireless Link Information – The Wireless Link 
Information command changes the visibility of 
wireless link quality information. 

� Rebuild Connections – The Rebuild Connections 
command rebuilds the connection map. 

Show Port LabelsShow Port LabelsShow Port LabelsShow Port Labels    

The Network Map can be displayed with or without information about the ports, 
which are used to connect your Devices. Ports are labeled with the sXpX 
nomenclature. The sXpX nomenclature designates particular physical interfaces 
available on your Device (e.g. s2p1 means physical Port  1 on the Interface Card 2). 

Wireless Link InformationWireless Link InformationWireless Link InformationWireless Link Information    

The Network Map may contain additional information on the quality of wireless 
links established between your Devices. 
 

 

� Signal Levels – The Signal Levels option  changes 
the visibility of the signal level information for 
wireless links between your Devices. 

� DS Channels – The DS Channels option changes 
the visibility of information about the used DS 
channels for wireless links between your Devices. 
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� DS Frequencies – The DS Frequencies option 
changes the visibility of information about the used 
DS frequencies for wireless links between your 
Devices.. 

� Link Utilization – The Link Utilization option 
changes the visibility of information about the 
utilization of wireless links between your Devices.. 

Rebuild ConnectionsRebuild ConnectionsRebuild ConnectionsRebuild Connections    

The Rebuild Connections command rebuilds immediately the connection map 
between your Devices displayed on the Network Map tab. You may need this 
command after changing the topology of your BriLAN Network. 
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THE HELP MENUTHE HELP MENUTHE HELP MENUTHE HELP MENU    

� 

This chapter provides information on the Help 
menu of BriLAN NMS. 

The Help menu of the BriLAN NMS program window contains commands for 
searching and browsing BriLAN on-line help file. 
You can access the following menu items in the Help menu of the BriLAN NMS 
program window: 
 

 

� BriLAN Help  
� BriLAN Home Page 
� BriLAN FAQ 
� BriLAN Technical Support 
� About 

BriLAN Help BriLAN Help BriLAN Help BriLAN Help     

Use the BriLAN Help command to get the list of available on-line help topics in 
alphabetical order. 

BriLAN Home PageBriLAN Home PageBriLAN Home PageBriLAN Home Page    

Use the BriLAN Home Page command to open the BriLAN home pages in your 
default browser. 

BriLAN FAQBriLAN FAQBriLAN FAQBriLAN FAQ    

Use the BriLAN FAQ command to open the BriLAN web pages about the 
frequently asked questions in your default browser. 

BriLAN Technical SupportBriLAN Technical SupportBriLAN Technical SupportBriLAN Technical Support    

Use the BriLAN FAQ command create a mail message addressed to BriLAN 
Technical Support with your default mail client. 
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AboutAboutAboutAbout        

Use the About command to determine the current version of your BriLAN NMS 
software.  
 

The About command opens the a window containing 
information on the current version and build number. 
It also provides information about the BriLAN 
copyright. Press the ESC button to close the about 
window. 
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THE EXPANDED VIEW WITHE EXPANDED VIEW WITHE EXPANDED VIEW WITHE EXPANDED VIEW WINDOWNDOWNDOWNDOW    

� 

This chapter provides information on the main 
menu of Expanded View window of BriLAN 
NMS. 

To perform network management tasks with a selected Device, continue in the 
Expanded View window.  
BriLAN NMS performs all remote control functions for management, forwarding, 
filtering, and monitoring of available network services (bridging, routing traffic 
shaping, virtual channeling), as well as traffic analysis and billing, built-in triggers and 
event logging in the one management system. Applied forwarding, filtering, and 
monitoring rules on selected BriLAN network services define your customized 
BriLAN Policies. 
 

There are several ways to open an 
Expanded View window for the 
Device: 
� Double-click the LED icon of 

the Device. 
� Double-click the icon of the 

Device on Network Map tab.  
� Double-click on the record of the 

Device on Device List tab and 
then click the Expanded View 
command. 

� Right-click on the icon of the 
Device on the Network Map 
tab and then click the Expanded 
View command.  

� Right-click on the record of the 
Device on Device List tab and 
then click Expanded View 
command. 

 
 
The Expanded View’s main menu of the BriLAN NMS program contains the 
following menu items: 
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� Device 
� Configure 
� BW Management 
� Users 
� View 
� Graph 

The Device statusThe Device statusThe Device statusThe Device status    

The Device status indicator pane informs you about the status and loading of 
currently running services on a selected Device. 
 

 

� CPU utilization - The CPU utilization variable displays 
the CPU performance graphs 

� Op Status - The Op Status variable provides 
information about the overall operation status of the 
selected Device: Clear OK means normal operation,  

� Bridging - The Bridging variable is set to “Enabled”, 
when the bridging service is enabled, and set to 
“Disabled”, when the bridging service is disabled. 

� Routing - The Routing variable is set  to “Enabled” 
when the routing service is enabled, and is set  to 
“Disabled” when the routing service is disabled. 

� Shaping - The Shaping variable is set to 
“Enabled”when the traffic shaping service is enabled, set 
to “Disabled” when the traffic shaping service is 
disabled. 

� Software Version - The Software Version identifier box 
gives you information about the version number of 
running BriLAN NOS (SW) and about its unique serial 
number (SN). 

Uptime counterUptime counterUptime counterUptime counter    

 The UpTime variable informs you about the elapsed time 
from the last restart of a selected Device. 

DeviceDeviceDeviceDevice    

The Device command of the Expanded View main menu provides accessibility to 
commands used for maintaining BriLAN NOS on a selected Device. 
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ConfigureConfigureConfigureConfigure    

The Configure command of the Expanded View main menu provides accessibility to 
the configuration commands of available services on a selected Device. 

BW ManagementBW ManagementBW ManagementBW Management    

The BW Management command of the Expanded View main menu provides 
accessibility to commands for applying the bandwidth management policy on a 
selected Device. 

UsersUsersUsersUsers    

The Users command of the Expanded View main menu provides accessibility to 
the database Network nodes on a selected Device. 

ViewViewViewView    

The View command of the Expanded View main menu allows you to change the 
Network Traffic activity pane on a selected Device. 

GraphGraphGraphGraph    

The Graph command of the Expanded View main menu allows you to work with 
Network Traffic activity data on a selected Device in graphical form. 
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THE EXPANDED VIEW METHE EXPANDED VIEW METHE EXPANDED VIEW METHE EXPANDED VIEW MENUNUNUNU    

� 

This chapter provides information on the 
Device menu of the Expanded View window of 
BriLAN NMS. 

The Device command of the Expanded View main menu provides accessibility to 
commands used for maintaining BriLAN NOS on a selected Device. 
Basic system maintenance operations include changing command accessibility, system 
upgrades and remote restarts. The Device popup menu of the Expanded View 
window contains the following menu items: 
 

� SysAdmin Level 
� Device Admin Properties 
� System Upgrade 
� Time Synchronization Master 
� Synchronize Device Time 
� Device Events 
� System Upgrade 
� Rebuild Connection Table 
� Device Restart 
� Close 

SysAdmin LevelSysAdmin LevelSysAdmin LevelSysAdmin Level    

The Open SysAdmin Level command of the SysAdmin Level popup menu 
enables access to the management features of your Device.  
When the remote management console communicates with your Device it checks the 
password of the System Administrator.  Authorized users work in so called 
SysAdmin Level mode. After completing installation a new BriLAN Network 
Device the default password is set to “SysAdmin”. 

Open SysAdmin LevelOpen SysAdmin LevelOpen SysAdmin LevelOpen SysAdmin Level    

Use of the remote management commands is password 
dependent. When passing to SysAdmin Level mode you 
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should enter the SysAdmin password. Valid passwords 
have a length between 6 and 20 characters and differentiate 
between upper and lower case letters. If you forget your 
SysAdmin password, establish a direct cable connection 
and enter a NEW password! 

Close SysAdmin LevelClose SysAdmin LevelClose SysAdmin LevelClose SysAdmin Level    

The Close SysAdmin Level command of the SysAdmin Level popup menu 
disables the use of management features of your Device.  
 

 
� Close SysAdmin Level - The yellow colored key on 

the left side to the Close SysAdmin Level command 
indicates that SysAdmin Level commands are enabled. 
For security reason it is recommended that SysAdmin 
commands are disabled by closing the SysAdmin 
Level mode when closing your BriLAN NMS session. 

� Change SysAdmin Password - The Change 
SysAdmin Password command of the SysAdmin 
Level popup menu changes the SysAdmin Level 
password. 

Device Admin PropertiesDevice Admin PropertiesDevice Admin PropertiesDevice Admin Properties    

The Device Admin Properties command of the Device menu is used to set basic 
identity and accessibility parameters of your Device like name, network address, etc. 
  

 

� Device Name – The Device Name box should 
contain a unique text identifier for your Device. 

� IP Address – The IP Address box should contain a 
unique IP Address reserved for your Device. 

� Subnet Mask – The Subnet Mask box should contain 
a network masquerading variable (e.g. 255.255.255.0 
for C-class networks). 

� Default Gateway – The Default Gateway box 
should contain a IP address of the gateway. 

System UpgradeSystem UpgradeSystem UpgradeSystem Upgrade    

The System Upgrade command of the Device menu is used for remote upgrades of 
BriLAN NOS (Image File, and Configuration Utility).  

 
� The BriLAN Image File command is used for 

remote upgrade of a previous version of BriLAN 
Image File over the network from BriLAN NMS to 
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the Device. 
� The BriLAN Configuration Utility command is used 

for remote upgrade of a previous version of BriLAN 
Configuration Utility over the network from BriLAN 
NMS to the Device. 

 
The Enter file name box is used for entering the name of an appropriate BriLAN 
NOS file for upgrade. 
 

 

Use the Browse button to select an 
appropriate BriLAN NOS file for upgrade. 

TimTimTimTime Synchronization Mastere Synchronization Mastere Synchronization Mastere Synchronization Master    

Date and time of your Devices connected to the BriLAN Network should be 
synchronized with the local system date and time on the computer running BriLAN 
NMS program. The time synchronization procedure works in automatic or manual 
mode. To use the automatic time synchronization method, one of your computers 
running BriLAN NMS should be defined as Time Synchronization Master (TSM). 
 

To define a PC as Time Synchronization 
Master for your BriLAN Network enter 
a valid IP address of the PC running 
BriLAN NMS. 
You can check the current assignment of 
TSM of your BriLAN Network in the 
Time Synchronization Master window.

Synchronize Network TimeSynchronize Network TimeSynchronize Network TimeSynchronize Network Time    

Date and time of your Devices connected to the BriLAN Network should be 
synchronized with the local system date and time on the computer running BriLAN 
NMS program. To synchronize time and date on your Devices you should be logged 
on to the Device with  system administrator rights (with opened SysAdmin level). 
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There are two methods to keep your 
Devices synchronized: 
Automatic Synchronization – TSM 
broadcasts time synchronization packets 
in your BriLAN Network (1 packet per 
hour), which are accepted by the Devices 
with selected Automatic Synchronization 
method. 
Manual synchronization – Requests 
immediate single-shot time 
synchronization for your Devices with 
the TSM. 
Current Time – The Current Time 
variable informs you abut the local system 
time. 

Device EventsDevice EventsDevice EventsDevice Events    

A Device connected to your BriLAN Network records actions, accessibility, 
warnings related to it’s operational status. 
To preview events registered in your Device, first select month, year and date in the 
upper pane, and than click Open button to display network events for a selected day. 
The Device Events window contains logged event records for the selected Device 
for a selected date. You can sort event records for a selected Device by clicking on 
the column headers. 
 

� Severity – The Severity variable is 
used for grouping events by 
authority categories. 

� Received at – The Received at 
variable contains time and date 
information, when the event was 
received. 

� Sent by – The Sent by variable 
contains the Device name, which 
sent the event. 

� Event Message – The Event 
Message variable contains detailed 
description of the given event 

Rebuild Connection TaRebuild Connection TaRebuild Connection TaRebuild Connection Tableblebleble    

Use the Rebuild Connection Table command of the Device menu to create a new 
connection map of your Devices (e.g. after adding a new Device). 
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Device RestartDevice RestartDevice RestartDevice Restart    

Use the Device Restart command of the Device menu to provide restart your 
Device remotely (e.g. after upgrading BriLAN NOS files). 

CloseCloseCloseClose    

The Close command of the Device menu is used for closing a session with a selected 
Device. 
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THE EXPANDED VIEW COTHE EXPANDED VIEW COTHE EXPANDED VIEW COTHE EXPANDED VIEW CONFIGURE NFIGURE NFIGURE NFIGURE 
MENUMENUMENUMENU    

� 

This chapter provides information on the 
Configure menu of the Expanded View window 
of BriLAN NMS. 

The Configure command of the Expanded View main menu provides accessibility to 
the configuration commands of available services on a selected Device. 
Using BriLAN NOS you can run the following network services (or any appropriate 
combination of them) on your Device: Bridge, Router, Virtual Channels which are 
available through  the Configure popup menu. The Expanded View’s Configure 
menu of the BriLAN NMS program contains the following menu items: 
 

 

� Bridging - The checkmark on the left side to the 
Bridging command indicates that the bridging service 
was started. 

� Routing - The checkmark on the left side to the 
Routing command indicates that the routing service 
was started. 

� Virtual Channels - The checkmark on the left side to 
the Virtual Channels command indicates that the 
Virtual Channels service was started. 

BridgingBridgingBridgingBridging    

Your BriLAN Device may operate as a MAC-layer multiport learning bridge. Your 
BriLAN bridge works on level 2 of reference OSI model with store and forward 
method of packet handling. It works with a maximum of 2048 learned nodes. 
Expired MAC addresses are flushed from the address table every 10 minutes. You 
can configure your bridge for packet filtering on MAC address level in following 
compatibility modes of IEEE standards:  IEEE 802.3  Ethernet, IEEE 802.3u 
FastEthernet, and IEEE 802.1d Transparent learning bridge. Using BriLAN bridge 
you can create up to 8 logical groups per port (VLAN). 
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� Enable Bridging – Click the Enable Bridging 
command, to change the status of the bridging 
service.  

� Bridge Group Manager – Click the Bridge Group 
Manager command, to create your filtering rules to be 
applied to the bridging service.  

� Broadcast Storm Protection – Click the 
Broadcast/Multicast threshold command to set a limit 
number of Broadcast/Multicast packets processed 
with the Device Interfaces.  

 

Enable BridgingEnable BridgingEnable BridgingEnable Bridging    

The checkmark on the left side to the Enable Bridging command indicates that the 
bridging service was started. Please note that the bridging service on a Device is 
started by default. When bridging is enabled, the Device works transparently to 
higher level protocols and defines the boundary of the collision domain. This feature 
means that your Device filters collisions and transfers only the packets coming from a 
port which is addressed to a network node connected to other ports. Because the 
remaining traffic is kept on the segment connected to a particular port your Device 
lowers the overall network traffic in your collision domain. 

Bridge Group ManagerBridge Group ManagerBridge Group ManagerBridge Group Manager    

Using the Device you can group Interface ports to create your virtual network groups 
(proprietary VLAN).  
When the bridging service is started for the Device, there are eight separate Bridge 
Groups available for aggregating individual Interface ports. This feature enables use 
of the Device as a “port-selective” packet filter, which controls the packet traffic 
between particular network segments. Packets directed between different Bridging 
Groups (coming from/to Ports in different Bridging Groups) are stopped on the 
Device. Packets are forwarded between the Interface Ports, which belong to the same 
Bridge Group, so end-nodes belonging to different Bridge Groups can't access each-
other. Please note that all ports belong by default to the Bridge Group 0. 
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The details pane of the Bridge 
Group Manager window 
contains the list of all Interface 
Ports (in the Port column) 
available for the Device with the 
current Bridge Group assignment. 
If the Interface Port is a member 
of a given Bridge Group the 
Enabled status-indicator displays 
this fact in the Group N column 
(where N=0..7). When the 
Interface Port is not a member of 
a Bridge Group you will find the 
Disabled status-indicator under 
Current Values. 
Bridging over a Port can be 
individually started or stopped. 
Use the Enable Bridging 
checkmark to change the status of 
the bridging service over the 
selected Port. Changing the Port 
bridging status does not affect the 
Port’s membership in a particular 
Bridging Group. If the Bridge 
Group is active, the Enabled 
status-indicator displays this fact 
under Current Values. 
 

Broadcast Storm ProtectionBroadcast Storm ProtectionBroadcast Storm ProtectionBroadcast Storm Protection    

The Broadcast Storm Protection command allows you to set a limit value of the 
number of Broadcast/Multicast packets processed with the Interfaces of your 
Device.  
Broadcasts and multicasts are natural part of Ethernet networks. However, if they 
overrun a certain limit they can significantly lower the network throughput. It is 
therefore a good idea to set a limit value of the number of Broadcast/Multicast 
packets which are transferred by your Device. 

 

You can set this limit in range 0-1000 pps. The Broadcast 
Storm Protection option is disabled when the threshold 
number is set to 0. 

Routing Routing Routing Routing     

You can set up your Device to provide IP-routing based on static routing tables. 
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The routing feature enables your Device to work at the network level of the 
OSI/ISO model, where packets are filtered by network node IP addresses and 
operate transparently to the application-level protocols. In this operating mode the 
Device defines the boundary of your multicast domain. When Routing is enabled you 
can configure a static table of IP routes for each Device, including the definition of 
individual Port IP addresses to be used to route designated packets. The routing table 
of your Device can contain up to 64 routing records (128 optional). Your BriLAN 
router supports TCP/IP, Frame Relay and PPP protocols. All Ports on your Device 
can be associated with a unique IP address. 
 

� Enable Routing – Click the Enable Routing 
command, to change the status of the routing service. 
The checkmark on the left side to the Enable Routing 
command indicates that the bridging service was 
started.   

� Configure Port IP Addresses – Click the Configure 
Port IP Addresses command to associate a router port 
with an IP address. 

� Configure Static Routes – Click the Configure Static 
Routes command, to create valid static IP routes for 
your BriLAN router. 

 
Use the Configure Port IP Addresses window to configure IP-specific properties of 
the selected physical Port. 
 

All Ports on your Device can be 
associated with a unique IP address. 
Provide this task BEFORE you create 
your IP routes.  
 

Use the IP properties pane of the Configure Port IP Addresses window to 
completely define an IP address of the selected Port. 
 

� Select Port – Select an available physical port in the 
Select Port drop down list to associate it with an IP 
address.  

� Port IP Address – Use a 4-byte valid IP address to 
associate it with a selected physical port. This IP 
address should be set on your network nodes as a 
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gateway address to communicate with the rest of your 
IP network or Internet. 

� Subnet Mask – Use a 4-byte network mask to 
masquerade your subnet connected to the selected 
physical port (e.g. Create a C-class network with 
255.255.255.0 mask). 

 
The Frame Relay pane of the Configure Port IP Addresses window is used to enter 
Frame Relay specific information. 
 

 

� DLCI – The DLCI edit box is used to set the DLCI 
service of your frame relay connection. 

� Transparent DLCI – Select the checkmark to create 
a transparent DLCI connection. 

 
Use the Static IP Routes window to define the routing table of your Device. 
 

 

The Static IP Routes window 
contains two main parts. In the 
upper portion you can define a 
new static route. In the detailed 
pane in the bottom part you can 
preview the configuration and 
status of all previously defined 
routes. 

Use the IP properties pane of the Static IP Routes window to define TCP/IP 
properties of your routes. 
 

 

� Target Network – Type a valid IP address of your 
subnet accessing via BriLAN router. 

� Network Mask – Use a 4-byte network mask to 
masquerade your subnet connected to the selected 
physical port (e.g. Create a C-class network with 
255.255.255.0 mask). 

� Gateway Address – Type a valid IP address to the 
Gateway Address edit box of a port which is used as a 
gateway to an accessed subnet. 

� Metric – Type a number to identify characteristic 
Metric of your subnet. 
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Virtual ChannelsVirtual ChannelsVirtual ChannelsVirtual Channels    

Virtual channels work as IP tunnels between two Devices. They allow you to 
connect your Voice devices over data networks (proprietary VoIP) and to transmit 
terminal data or integrate your distant subnets over the Internet. Data directed to 
your virtual channel on the selected Device is encapsulated to IP packets and 
forwarded to the next Device. 
Virtual channels work only with properly configured IP networking. Because you can 
create a Virtual Channel only if the second Device is accessible Your Device Map 
should contain at least two Devices. 
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THE EXPANDED VIEW BATHE EXPANDED VIEW BATHE EXPANDED VIEW BATHE EXPANDED VIEW BANDWIDTH NDWIDTH NDWIDTH NDWIDTH 
MANAGEMENT MENUMANAGEMENT MENUMANAGEMENT MENUMANAGEMENT MENU    

� 

This chapter provides information on the 
Bandwidth Management menu of the Expanded 
View window of BriLAN NMS. 

The BW Management command of the Expanded View main menu provides 
accessibility to the commands of available bandwidth management policy on a 
selected Device. 
Speed limit and queue membership are customizable rules within the Bandwidth 
Management policy of your Device. The Expanded View’s BW Management 
menu of the BriLAN NMS program contains the following menu items: 
 

 

� Traffic Shaping  
� Packet Priority Queue 

Traffic ShapingTraffic ShapingTraffic ShapingTraffic Shaping    

You can set up your Device to regulate packet transfer rate on ports or network 
nodes meeting your specific demands on the network throughput. Use this feature 
when your setup requires limited data flow on a physical Port or logical group of 
Network Nodes. 
Without limiting the packet transfer rate you can achieve traffic performance up to 
maximum Ethernet/FastEthernet speed  (depending on the hardware used) or up to 
22 Mbps when using radio. Use this feature when your setup requires limited data 
flow on a physical Port or logical group of Network Nodes.  
You can include your bridging or routing Ports or your Network Nodes defined by 
MAC or IP addresses in 128 independent Traffic Shaping Queues. Traffic queues 
with 512 Kb shared software data buffer, working at user defined data speed limit 
within speed range 32-4049 Kbps, can be independently started or stopped.  
Speed limit and queue membership are customizable rules, available in Traffic 
Shaping Manager.  
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TS Manager – Use Enable 
Traffic Shaping command in 
the TS Manager menu to 
activate the traffic shaping 
service on your Device. Please 
note that the traffic limiting 
rules should have been set 
previously (by means of 
Enabled and Started queues). 
Users – Use the Users 
command to set network node 
assignment within individual 
traffic shaping queues in cases 
where your queues are defined 
at Node level. 

 
To bring the Traffic Shaping Service to operational state please ensure the 
following: Enable at least one queue, set the level of the queue assignment, select 
assigned ports or Network Nodes, set the speed limit and speed limiting mode, and 
finally activate the Traffic Shaping as a service on your Device. You can use Named 
Queues for easier orientation in your traffic shaping rules. 
 

� Enable – The pushed  
(green lighting) button  
indicates, that the selected 
traffic shaping queue in 
the drop-down list was 
enabled (please note that it 
does not mean that the 
queue was Started).  

� Start – The pushed (green 
lighting) button indicates 
that the queue was started. 
with the selected speed 
limits. By default your 
queue works in Bypass 
mode  unless you push the 
start button. 

 
 
Use the Queue Assignment pane to set the type of queue membership. Traffic 
Shaping Queues may contain Ports or Network Nodes. The appropriate Network 
Node assignment may be controlled in the Users menu of the Traffic Shaping main 
menu at MAC or IP addresses mode. 
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� Users Level – Use the Users Level option to define 
the queue membership per network node level (by 
MAC or IP addresses) 

� Port Level– Use the Port Level option to define the 
queue membership per physical port level. 

� Discard – Use the Discard button to completely delete 
packets in a selected queue. 

 
Queue Speed Limit – Use the Queue Speed Limit pane to set the speed limitation 
mode and threshold parameters for a selected queue. You can define limits for 
incoming and outgoing packets in Duplex Speed Limiting mode or you can set the 
overall amount of transferred packets if the Duplex Speed Limiting mode is off. 
 

 

� IN –  Defines the incoming speed limit in kilobits per 
second (per port in port assignment mode or per 
network node group in user level mode) 

� OUT –  Defines the outgoing speed limit in kilobits 
per second (per port in port assignment mode or per 
network node group in user level mode) 

� Set – Use the Queue Speed Limit text box to set the 
speed limit for a selected queue. 

� Duplex – You can split each queue into two portions 
for incoming and outgoing data. Select the Duplex 
mode to define speed limits separately for each 
portion. If Duplex is off, you can set the overall 
amount of transferred packets over the queue. 

 
The Queue Speed Limit popup menu contains 10 different pre-defined levels of 
traffic speed limit.  
 

 

� 32 Kbps – Traffic speed limit is set to 32 kilobits per 
second 

� 64 Kbps – Traffic speed limit is set to 64 kilobits per 
second 

� 128 Kbps – Traffic speed limit is set to 128 kilobits per 
second 

� 256 Kbps – Traffic speed limit is set to 256 kilobits per 
second 

� 1024 Kbps – Traffic speed limit is set to 1024 kilobits 
per second 

� 1536 Kbps – Traffic speed limit is set to 1536 kilobits 
per second 

� 2048 Kbps – Traffic speed limit is set to 2048 kilobits 
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per second 
� 4096 Kbps – Traffic speed limit is set to 4096 kilobits 

per second 
� No Speed Limit – No traffic speed limit is applied. 

Queue execution rulesQueue execution rulesQueue execution rulesQueue execution rules    

Traffic shaping rules defined on MAC Address Level have higher execution priority  
level than traffic shaping rules defined on IP MAC Address Level. Traffic shaping 
rules defined on User Level have higher execution priority level than traffic shaping 
rules defined on Port Level. 

Packet QuePacket QuePacket QuePacket Queue Priorityue Priorityue Priorityue Priority    

The QoS command of the Expanded View main menu provides accessibility to 
commands for tuning Quality of Services on a selected Device. 
Your network setup may contain requirements on guaranteed network throughput 
which is achievable using packet priority rules. Data in each priority queue is handled 
by independent 512 kB buffers.  
 

The Port Level QoS window is 
divided into 3 panes. Each portion 
contains data counters for network 
throughput in the particular queue. 
Act – shows the current throughput 
measured in bytes per second. 
Avg – shows the average throughput 
measured in bytes per second. 
Max – shows the highest 
throughput measured in bytes per 
second. 
The amount of data transferred is 
displayed for the Last 5 seconds 
and as Total amount. Current 
Buffer Usage is given as a 
percentage. 

 
Your Device has 3 different level of packet priority queues implemented: High, 
Medium, and Low. 
 

 

High packet priority queue – packets are transmitted 
immediately − should be allocated to your Voice data or 
media streams. 
Medium packet priority queue – packets are transmitted 
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with lower priority compared to  the High packet queue.  
Low packet priority queue – packets are transmitted with 
the lowest priority.  

 
The Assigned Ports pane contains the list of each assigned port with the selected 
packet priority queue. 
 

 

To change the packet priority queue assignment use the 
Packet Queue Priority command in the Expanded View 
window. 
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THE EXPANDED VIEW USTHE EXPANDED VIEW USTHE EXPANDED VIEW USTHE EXPANDED VIEW USERS MENUERS MENUERS MENUERS MENU    

� 

This chapter provides information on the Users 
menu of the Expanded View window of 
BriLAN NMS. 

The Users command of the Expanded View main menu provides accessibility to the 
database Network nodes on a selected Device. 
To make it easier to work with MAC and IP addresses within your Device, you can 
provide additional information to the built-in network node database. You can use 
this data if the Device is used for billing of your users (e.g. you are using it as a 
connection point for providing Internet Services). You can browse and sort your 
database using clickable table headers in the details pane (User Name, MAC 
Address, IP Address, Port, Net Mask, Status, TSQ, and Denied Ports).  
The Expanded View Users menu of the BriLAN NMS program contains the 
following menu items: 
 

 

� Mac Address Level 
� IP Address Level 

MAC Address LevelMAC Address LevelMAC Address LevelMAC Address Level    

The MAC Address Level Users command provides accessibility to the built-in 
network node database on stored MAC addresses. 
 

The MAC Address database is used 
for evaluating forwarding rules when 
your Device is working in level 2 
mode (MAC Address Tables). MAC 
addresses are added automatically 
(learning bridge). When the node is 
inactive for more than 10 minutes 
MAC addresses are removed 
automatically (flushed) if no 
additional information is provided 
for that address manually (User 
Name, TSQ assignment...). 
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MAC Address Level Users edit boxes allows you to identify your network nodes 
(Network Node Identifiers) by First and Last Name (usually of characteristic user) 
and with additional information (usually address, room or phone number, e-mail of 
users). 
 

� Not Assigned – This MAC Address record has 
empty First Name / Last Name boxes. 

� First Name – The First Name box usually contains 
the First Name of a user. 

� Last Name – The Last Name box usually contains 
the Last Name of a user. 

� Info – The Info box usually contains address, room 
or phone number, e-mail of a user. 

� MAC Address – The MAC Address box holds the 
physical address of the selected network node 
(determined by the Device). 

� On Port – The On Port box contain the physical 
location of the selected network node (determined by 
the Device). 

 
The TSQ (Traffic Shaping Queue) assignment drop-down window allows you to 
individually assign any listed MAC Address record to an appropriate traffic-limiting 
queue. 
 

 

You can assign any MAC Address record to 64 TSQ 
numbered from 1 up to 64. To remove the TSQ 
assignment select the NOT option. Please note that to 
properly configure the traffic shaping queue, you should 
enable the selected queue, set an appropriate traffic speed 
limit (in range 32 - 2048 kilobytes per second) and start 
the Traffic Shaping Service on the Device. 

 
The Port Accessibility pane of the MAC Address Level Users window allows you 
to set Port Accessibility for a selected MAC Address record.  
 

 

When the Port is Permitted for a selected MAC Address 
record packets containing this source MAC address are 
transferred (if necessary) through the port (the port is 
working in transparent mode for that address). 
When the Port is Denied for a selected MAC Address 
record packets containing this source MAC address are 
blocked on the port (No traffic containing this source 
address goes trough the port). 
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MAC Address Record counter displays information about the record position. 

 This counter, located in the down-left corner of the MAC 
Address Level Users window, displays your current 
position in the MAC Address database of the Selected 
Device. It also gives the current size of the MAC 
Address database. 

 
Device/NMS Database tabs allow you to select the displayed database. 
 

 

Because the network node database is stored on each 
individual Device, you can use both the Device (local) and 
NMS Database (Distributed). Each Device can store up to 
2048 record in it’s own local MAC Address Level Users 
database. 

 
Using these buttons you can sort the displayed database records. 
 

 
User Name  The User Name button sorts the records of selected MAC 

Address database by user names. 
MAC Address The MAC Address button sorts the records of selected MAC 

Address database by contained MAC Address codes. 
Port The Port button sorts the records of selected MAC Address 

database by Port codes (Port means the Port where the segment 
containing the MAC address is connected). The SxPx 
nomenclature is used. 

Status The Status button sorts the records of selected MAC Address 
database by Activity status (The network node is regarded to be 
active when your Device received a packet coming from that 
node in the last 10 minutes) The status defined are: Active, 
Inactive, NotInTable. 

TSQ The TSQ button sorts the records of selected MAC Address 
database by Traffic Shaping Queue status 

Denied Ports The Denied Ports button sorts the records of selected MAC 
Address database by Port Accessibility status 

File menu of MAC Address LevelFile menu of MAC Address LevelFile menu of MAC Address LevelFile menu of MAC Address Level    

You can define the default Port Accessibility Policy using the File menu of MAC 
Address Level window. 
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The MAC address table is a dynamic database of “known” 
MAC addresses of Network Nodes. When your BriLAN 
bridge learns a MAC address of a new Network Node, it 
stores some information about that Network Node to its 
MAC address table. By default Network Nodes have no 
accessibility restrictions on the local Ports of your Device.  

 
Port Accessibility Policy is a set of rules which controls forwarding packets over a 
selected Port or Ports on your Devices. 
 

 

Using the Default Port Accessibility option you 
can block “piracy” connections to your network, 
because Denying the Port Accessibility causes that 
traffic from/to any newly learned Network Node to 
be stopped on selected ports. This means you can 
manually control and then authorize all Network 
Nodes in your BriLAN Network.  

Popup menu of details pane of the MAC Address Popup menu of details pane of the MAC Address Popup menu of details pane of the MAC Address Popup menu of details pane of the MAC Address 
LevelLevelLevelLevel    

 

 

� Change TS Queue Assignment – Use this 
command, to individually change the assignment 
of a selected Network Node with traffic shaping 
queues. 

� Synchronize Database Record – Synchronizes 
the content of a selected record. 

� Add Record to Device Database – Adds 
selected records with Status NotInTable to the 
Device database. 

� Remove Record(s) From – Removes selected 
entries from a specified Device Database (local 
or distributed). 

� Select All Records – Selects all database records 
listed in details pane.  

� Search MAC Address in Network – Use this 
command to search for specific MAC addresses 
using the whole distributed BriLAN Device 
Database. 
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IP Address LevelIP Address LevelIP Address LevelIP Address Level    

The IP Address Level Users command provides accessibility to the built-in network 
node database based on stored IP addresses. 
 

The IP Address database used for 
evaluating forwarding rules when 
your Device is working in level 3 
mode (Routing Tables). IP addresses 
are added automatically. When the 
node is inactive for more than 10 
minutes IP addresses are removed 
automatically (flushed) if no 
additional information has been 
provided for that address manually 
(User Name, TSQ assignment...).

 
IP Address Level Users edit boxes allows you to identify your network nodes 
(Network Node Identifiers) by First and Last Name (usually of characteristic user) 
and with additional information (usually address, room or phone number and e-mail 
of users). 
 

� Not Assigned – This IP Address record has empty 
First Name / Last Name boxes. 

� First Name – The First Name box usually contains 
the First Name of a user. 

� Last Name – The Last Name box usually contains 
the Last Name of a user. 

� Info – The Info box usually contains address, room 
or phone number and e-mail of a user. 

� IP Address – The IP Address box contains the 
logical address of a network node determined by the 
Device. 

� Mask – The Mask box contains Network 
masquerading associated with a network node. 

 

User Name  The User Name button sorts the records of selected IP Address 
database by user names. 

IP Address The IP Address button sorts the records of selected IP Address 
database by contained IP Address codes. 

Net Mask The Net Mask button sorts the records of selected IP Address 
database by Net Mask codes.  
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Status The Status button sorts the records of selected IP Address 
database by Activity status (The network node is regarded to be 
active when your Device has received a packet coming from that 
node within the last 10 minutes) 

TSQ The TSQ button sorts the records of selected IP Address 
database by Traffic Shaping Queue status 

Denied Ports The Denied Ports button sorts the records of selected IP Address 
database by Port Accessibility status 
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THE EXPANDED VIEW VITHE EXPANDED VIEW VITHE EXPANDED VIEW VITHE EXPANDED VIEW VIEW MENUEW MENUEW MENUEW MENU    

� 

This chapter provides information on the View 
menu of the Expanded View window of 
BriLAN NMS. 

The View command of the Expanded View main menu allows you to change the 
Network Traffic activity pane on a selected Device. 
The Expanded View window displays information about the installed Interfaces both 
in graphical and in tabular form. You can switch the view of a selected Device’s 
Interfaces between the Slot Panel displayi mode and the Graph Panel display mode. 
If the Slot Panel display mode is active you can check the overall Interface activity 
visually – using the LED diodes. If the Graph Panel display mode is active you can 
use the network traffic diagrams for viewing the time-dependence of your particular 
Interface cards. 

 

� Slot Panel 
� Graph Panel 

Slot PanelSlot PanelSlot PanelSlot Panel    

The Slot Panel pane of the Expanded View window contains Interfaces installed in 
your Device. 

 

Eth – Ethernet interface 
Wls – Wireless interface 
Act – The LED is on when the Port is active 
Stat – The LED is on when the Port is active 

 
The CPU Slot provides accessibility to system specific information. 

 

The overall performance of your Device depends mainly 
on the CPU performance. Higher frequency of the CPU 
gives better data throughput on your Device. Your Device 
should equipped at least with 4 MB of RAM. 
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Graph PanelGraph PanelGraph PanelGraph Panel    

The Graph Panel pane of the Expanded View window contains time dependent 
diagrams of your Interface activities installed in your Device. 
Type CTRL+G to display the Graph Panel. 
 

 

The independent axis contains the time 
window you want to display. You can change 
the displayed Collection Period from the last 5 
minutes (shortest time slot) to last week data 
(the maximum extent of historical data stored). 
The dependent axis may contain any 
characteristics describing the network activity 
measured on the selected Interface. You may 
combine multiple data series using drag and 
drop technique for selecting traffic data. You 
can combine ONLY the same type of data 
series coming from different Ports. Each data 
series is displayed with a unique color-code. 

Expanded view Port popup menuExpanded view Port popup menuExpanded view Port popup menuExpanded view Port popup menu    

By right clicking any Interface in the Slot Panel you can display the appropriate 
popup menu.  
You can access additional information on port settings, traffic statistics, packet 
distribution, link quality or you can change the port configuration, queue assignment 
or port accessibility. 
 

 

� Advanced Port Info 
� Advanced Port Statistics 
� Packet Length Distribution 
� Wireless Link Quality Details 
� Configure Port 
� Packet Queue Priority 
� Reset Port 
� Enable/Disable Port 

Advanced Port InfoAdvanced Port InfoAdvanced Port InfoAdvanced Port Info    

The Advanced Port Info command provides information on the Interface card 
hardware. The displayed information may vary depending on the examined Interface 
type. 
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� Operational status 
� Hardware 
� Driver Name 
� HW Address 
� HW Interrupt 
� I/O Address 
� Memory Address 
� Port Speed 
� Duplex 
� TX Buffer Size 
� RX Buffer Size 
� Connector Type 

What are the functions of each the above? Do they 
need to be explained or are they self evident? 

Advanced Port StatisticsAdvanced Port StatisticsAdvanced Port StatisticsAdvanced Port Statistics    

The Advanced Port Statistics command provides information on basic and 
additional network traffic information. 
 

 

You can access any traffic counter 
available for that Interface: 
Standard statistics 
Advanced Statistics 
Use the rulers to get access to hidden 
statistics counters. To create a time-
dependent diagrams of a selected 
counter drag and drop the 
appropriate cell under the Counter 
column. 

 
Standard statistics pane provides access to standard statistics counters (common 
for all interfaces) 
 

 

� Frames in/out 
� Bytes in/out 
� Errors in/out 
� Dropped in/out 
� ActUtil in/out 
� ActBitRate in/out 
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Advanced Statistics pane provides access to advanced statistics counters (specific 
for each interfaces) 

 

 

� CRC Error 
� RX FIFO Overrun 
� RX Buffer  Overrun 
� Invalid Symbol 
� Frame Alignment Error 
� RX Frame Short 
� RX Frame Long 
� TX Buffer Underrun 
� Transmit Abort 
� Number of Collisions 
� Excessive Collisions 
� Carrier Sense Lost 
� CD Heart Beat 
� Interface Reset 
� PCI Bus Error 
� CRC Error 
� RX Overrun 
� Dribble Bit 
� Abort End Detected 
� RX Frame Short 
� RX Frame Long 
� TX Buffer Underrun 
� TX Jabber Error 
� Excessive Collisions 
� Multiple Collisions 
� Single Collisions 
� Carrier Sense Lost 
� TX Deferred. 
 

Packet Length DistributionPacket Length DistributionPacket Length DistributionPacket Length Distribution    

The Packet Length Distribution command provides information on the length 
distribution of packets in your network. 
 

 

The information is displayed using 
distribution diagrams of 6 predefined 
characteristic packet size intervals 
given in bytes for Received and 
Transmitted packets respectively:  
• 60-63 bytes 
• 64-127 bytes 
• 128-255 bytes 
• 256-511 bytes 
• 512-1023 bytes 
• 1024-1518 bytes 
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To change interdependent scaling of the displayed diagrams right-click the graph 
areas. 

 

You can change the displaying mode of your 
diagrams between Own Maximal Values, 
Common Maximal Values and Percentage 
View when you right-click the graph area. 

Wireless Link Quality DetailsWireless Link Quality DetailsWireless Link Quality DetailsWireless Link Quality Details    

The Wireless Link Quality Details command allows you to tune the quality of your 
wireless links in real-time directly from BriLAN NMS application.  
This command helps you to find the best position and direction of your antenna 
mountings. 

Reset PortReset PortReset PortReset Port    

Use the Reset Port command to reset a selected port without resetting the whole 
Device. 

Configure PortConfigure PortConfigure PortConfigure Port    

The Configure Port command allows you to change the Port-operating parameters 
remotely. 
The displayed information may vary depending on the examined Interface type. 
 

 

Select this command to change Data Rate, 
Duplex mode or other applicable hardware 
settings. This command is available if there is 
any hardware parameter to change.  
To change settings  select a new value from the 
appropriate drop-down menu under New 
Values. 

Packet Queue PriorityPacket Queue PriorityPacket Queue PriorityPacket Queue Priority    

The Packet Queue Priority command allows you to change the Packet Queue 
assignment for the Selected Port. 
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Your network setup may contain requirements on 
guaranteed network throughput (e.g. voice/video 
streams) achievable using packet priority rules. Your 
Device has three different level of packet priority queues 
implemented: 
�High packet priority queue – packets are transmitted 

immediately. Allocate your Voice data or media streams 
to this queue.. 

�Medium packet priority queue – packets are 
transmitted with lower priority compared to the High 
packet queue. 

�Low packet priority queue – packets are transmitted 
with the lowest priority.  

To view the assignment of the Quality of Services priority 
Queues, click the QoS menu item in the Expanded View 
main menu. 

Enable/Disable PortEnable/Disable PortEnable/Disable PortEnable/Disable Port    

The Enable/Disable Port command allows you to change the port operation status. 
If the Port is disabled, ALL network traffic is completely stopped over this Port. Use 
this command when you need to disable the traffic (bridging and routing) 
immediately on a selected port, regardless of the Queue or Bridge Group assignment 
or port configuration. 

Expanded view CPU popup menuExpanded view CPU popup menuExpanded view CPU popup menuExpanded view CPU popup menu    

By right clicking on the CPU slot you can display the appropriate CPU popup menu.  
You can access additional information on the System Main Board or you can get the 
CPU utilization diagram. Using this command you can check remotely RAM 
availability on your Devices. 
 

 

� System Information 
� CPU Utilization in Graph 

System InformationSystem InformationSystem InformationSystem Information    

The System Information command provides information on the System 
MainBoard, like CPU type, and RAM assignment. 
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� CPU Type – provides information about the installed 
CPU. 

� Device S/N – provides information about the 
Device’s serial number 

� BriLAN NOS – provides information about the serial 
number. 

� Main Memory – provides information about the total 
RAM capacity. 

� High Memory Block – provides information about 
the installed HMB memory. 

� Extended Memory– provides information about the 
installed EMB memory. 

CPU Utilization in GraphCPU Utilization in GraphCPU Utilization in GraphCPU Utilization in Graph    

The CPU Utilization in Graph displays the CPU performance graphs on the 
selected time-scales from the last 5 minutes up to last week. 
 

 

The independent axis contains the 
time window you want to display. You 
can change the displayed Collection 
Period from the last 5 minutes 
(shortest time slot) to last week data 
(the maximum extent of historical 
data stored). 
The dependent axis contains the CPU 
performance of a selected Device. 
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THE EXPANDED VIETHE EXPANDED VIETHE EXPANDED VIETHE EXPANDED VIEW GRAPH MENUW GRAPH MENUW GRAPH MENUW GRAPH MENU    

� 

This chapter provides information on the 
Graph menu of the Expanded View window of 
BriLAN NMS. 

The Graph command of the Expanded View main menu allows you to work with 
Network Traffic activity data on a selected Device in graphical form. 
Knowing the exact status of your network may help to better understand current 
network requirements of your users. It can also assist in planning future development 
of your network infrastructure. The Device works as a continuous network traffic 
monitor constantly  keeping an eye on your network. Using the Graph menu you can 
easily find all network load statistics in various time-scales, zoom in on specific 
information, locate your top-talker network nodes or error generating items. 
 

 

� Collection Period 
� Logarithmic View 
� Remove Series 

The Graph menu enables the following tasks: selecting information to display, 
configuring graph scaling, zooming in/out of a particular graph area, selecting normal 
or logarithmic scaling and displaying multiple data series. 

CollCollCollCollection Periodection Periodection Periodection Period    

The Collection Period command displays the selected time period of the traffic data 
series. 

 

You can choose from several types of data collection 
periods, ranging from a very short time (5 minutes) up to 
the last week. By choosing a time interval you can change 
the current time-focus.  
� Last 5 minutes 
� Last Hour 
� Last Day 
� Last Week 
By default the Last 5 minutes period is selected. 
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Logarithmic ViewLogarithmic ViewLogarithmic ViewLogarithmic View    

The Logarithmic View command switches the displaying mode of the selected 
traffic data series between normal and logarithmic view.  
 
 When you switch to logarithmic view all network traffic 

data is transformed with Decadical (????) Logarithmic 
function before plotting the graph. You may have traffic 
data with various amplitudes ranging from very small 
values up to very high ones. In such cases it is useful to 
display your graphs in logarithmic scaling. The default view 
is “normal” display mode. 

Remove SeriesRemove SeriesRemove SeriesRemove Series    

The Remove Series command removes the selected data series from the Graph 
Area. 

 

Individual data series belonging to physical ports on the 
interfaces are color-coded. You may remove any data 
series listed in the data series popup menu.  
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SERIAL LINE CONSOLE SERIAL LINE CONSOLE SERIAL LINE CONSOLE SERIAL LINE CONSOLE WINDOWWINDOWWINDOWWINDOW    

� 

This chapter provides information on the Serial 
Line Console window of BriLAN NMS. 

 
The Serial Line Console is used for setting up initial operating parameters of the 
BriLAN NOS software. 
Set up of BriLAN NOS requires a temporary serial cable connection between the 
BriLAN NMS and the Device. COM1 port on the Device with 0x3F8 I/O address 
and IRQ=4 is dedicated for BriLAN NOS!  You should use this port of the Device 
during the serial cable connection. Because the COM1 port is usually connected to a 
mouse pointing device on your BriLAN Management Station, we suggest using 
another available serial port. If the port is busy with other than your Device you may 
obtain the message: “Can't open port COMx!”  If your Device is unreachable through 
the network then the direct serial cable connection is the ONLY WAY to modify its 
operating parameters! 
 

All interface card specific settings of 
the BriLAN NOS software should be 
matched with Interface card settings 
provided by Manufacturer's Interface 
Setup Utility programs. Other relevant 
BriLAN NOS operating data is also 
added here. When you are working 
with the Serial Line Console, the 
BriLAN NMS communicates with the 
BriLAN Configuration Utility 
(BCU) program located on your 
Device. 
The basic set up of BriLAN NOS 
requires a temporary serial cable 
connection between BriLAN 
Management Station and the 
Device.  

 
Interface specific settings of the BriLAN NOS software should be matched with 
Interface settings provided by Manufacturer's Interface Setup Utility programs.  
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Interface Type 
Hardware 
IRQ 
I/O Address 
Mem Address 
Extra Address 

 
The main menu of the BriLAN Configuration Utility program window contains 
commands for completely configuring your Device by connected to BriLAN NMS 
via serial line. 
 

 
File The File command of the BriLAN Configuration Utility 

program window opens a submenu commands for saving, 
and resetting the changes performed in the Serial Line 
Console and resetting your Device. 

Console Use the Console command of the BriLAN Configuration 
Utility program window to change the operating 
parameters of the serial port connection. 

SysAdmin Use the SysAdmin command of the BriLAN 
Configuration Utility program window to change password 
of the system administrator and IP networking properties 
of your Device. 

Bridging Use the Bridging command of the BriLAN Configuration 
Utility program window to configure bridging service on 
your Device. 

Routing Use the Routing command of the BriLAN Configuration 
Utility program window to configure routing service on 
your Device. 

Available Interfaces Use the Available Interfaces command of the BriLAN 
Configuration Utility program window to automatically 
find the configuration of all installed interfaces on your 
Device. 

 
The details pane of the Serial Console Window contains detailed information about 
the installed interfaces in your Device. 
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Slot The Slot column contains information about the type of a 
particular Interface. 

Hardware The Hardware column contains information on the brand. 
of a particular Interface. 

IRQ The IRQ column contains information about the unique 
interrupt request number using your Device when accesses 
a particular Interface. 

MemAddr. The MemAddr. column (applicable to Synchronous and 
Asynchronous Interface types) contains information about 
a block of physical memory address resources for a 
particular Interface. 

Ext.Addr. The Ext.Addr. column defines the extra address resources 
for a particular Interface. 

File menu of the BCU windowFile menu of the BCU windowFile menu of the BCU windowFile menu of the BCU window    

The File menu of the BriLAN Configuration Utility program window contains 
commands for saving, and resetting the changes performed in the Serial Line 
Console and resetting your Device. 
 

 

� Save Settings to Device – Use the Save Settings to 
Device command to save new configuration to your 
Device. 

� Reset Device to Default – Use the Reset Device to 
Default command recall the “factory” settings of your 
Device. 

� Restart Device – Use the Restart Device command to 
remotely restart your Device. 

� Exit – The Exit command quits execution of the 
BriLAN Configuration Utility program. 

Console menu of the BCU windowConsole menu of the BCU windowConsole menu of the BCU windowConsole menu of the BCU window    

Use the SysAdmin menu of the BriLAN Configuration Utility program window to 
change password of the system administrator and IP networking properties of your 
Device. 
 

 

Serial Port Settings – Use the Serial Port Settings 
command to set communication parameters of the serial 
port where your Device is connected. 
Connect to Device – Click the Connect to Device 
command to establish a new serial line connection to your 
Device. Reboot your Device immediately after the 
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“waiting” dialog appears. 

Serial Port SettingsSerial Port SettingsSerial Port SettingsSerial Port Settings    

Use the Serial Port Settings window to set communication parameters of the serial 
port where your Device is connected. 
 

 

� Port – Use the Port box of the Serial Port Settings 
window to set the requested serial port, where your 
Device is connected. 

� Baud Rate – Use the Bits per second box of the Serial 
Port Settings window to set the requested connection 
speed for your Device in bauds per seconds. 

� Parity – Use the Parity box of the Serial Port Settings 
window to set the parity information to none. 

� Data bits – Use the Data Bits box of the Serial Port 
Settings window to set the number of data bits to 8. 

� Stop bits – Use the Stop Bits box of the Serial Port 
Setting s window to set the number of stop bits to 1. 

SysAdmin menu of the BCU windowSysAdmin menu of the BCU windowSysAdmin menu of the BCU windowSysAdmin menu of the BCU window    

Use the SysAdmin menu of the BriLAN Configuration Utility program window to 
change password of the system administrator and IP networking properties of your 
Device. 
The remote management of your Device, controlled by BriLAN NMS, is available 
in normal operation mode via standard network connectivity. Without specifying the 
password of the Device, the traffic and status data are available, but all management 
functions are disabled. Setting up parameters via serial cable does not require 
authorization using SysAdmin Password. 
 

� Change SysAdmin Password – The Change 
SysAdmin Password command of the SysAdmin 
Level popup menu changes the SysAdmin Level 
password. To improve management security, you can 
change the default password “SysAdmin“. 

� SysAdmin Device Properties –  The Device Admin 
Properties command of the Device menu enables use 
of the  management features of your Device. 

Device Admin Properties windowDevice Admin Properties windowDevice Admin Properties windowDevice Admin Properties window    

Use the Device Admin Properties window to set the name of your Device and its 
basic IP networking properties. 
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Your Device communicates in normal operating mode with the BriLAN NMS via 
standard IP protocol. To make your Device accessible in your network set particular 
IP networking properties. Because the management uses a routable protocol you can 
manage your Devices, operating in your LAN connected to the Internet, from any PC 
with Internet connectivity. 
 

 

� Device Name – The Device Name box should 
contain a unique text identifier for your Device. 

� IP Address – The IP Address box should contain a 
unique IP Address reserved for your Device. 

� Subnet Mask – The Subnet Mask box should 
contain a network masquerading variable (e.g. 
255.255.255.0 for C-class networks). If your network 
is not interconnected with other ones, you can leave 
this box empty. 

� Default Gateway – The Default Gateway box 
should contain a IP address of the gateway. 

 

BridBridBridBridging menu of the BCU windowging menu of the BCU windowging menu of the BCU windowging menu of the BCU window    

Click the Enable Bridging command, to change the status of bridging service. 

 � Enable Bridging –The checkmark on the left side to 
the Enable Bridging command indicates that the 
bridging service was started. Please note that the 
bridging service on a Device is started by default. 

Routing menu of the BCU windowRouting menu of the BCU windowRouting menu of the BCU windowRouting menu of the BCU window    

Click the Routing command of the main menu of the Serial Console Window to 
configure the routing service of your Device. 
 

 

� Enable Routing – The checkmark on the left side to 
the Enable Routing command indicates that the 
bridging service was started. Please note that the port 
IP address and at least one static route should be 
configured before enabling the routing service. 

� Configure Port Ip Address – Click the Configure 
Port IP Addresses command to associate a router port 
with an IP address. 

� Configure Static Routes– Click the Configure Static 
Routes command, to create valid static IP routes for 
your BriLAN router. 
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Available Interfaces menu of the BCU Available Interfaces menu of the BCU Available Interfaces menu of the BCU Available Interfaces menu of the BCU 
windowwindowwindowwindow 

Use the Available Interfaces submenu of the BriLAN Configuration Utility program 
window to automatically find the configuration all installed interfaces on your Device. 
You can find here general  information about installed interface cards (brand name, 
type, bus type), IRQ and addressing accessibility. 
 

 
Card Name The Card Name column provides information about the 

brand name of a particular Interface. 
HW Type The HW Type column provides information about the 

type of a particular Interface. 
Bus The Bus column provides information about the bus type 

(ISA/PCI) of a particular Interface. 
IRQ The IRQ column provides information about the unique 

interrupt request number using your Device when accesses 
a particular Interface. 

IoAddr The IOAddr column provides information about the 
physical I/O address resources set for a particular 
Interface. 

Space The Space column provides information about the I/O 
address resources reserved space for a particular Interface 
in bytes. Within this space no overlaps are permitted 
between the installed interfaces. 

MemAddr The MemAddr. column provides information about the 
Memory Address resources set for a particular Interface. 

Space The Space column provides information about the 
Memory Address reserved space for a particular Interface 
in bytes. Within this space no overlaps are permitted 
between the installed interfaces. 

ExtAddr The Ext.Addr. column provides information about the 
extra address resources set for a particular Interface. 

Space The Space column provides information about the Extra 
Address reserved space for a particular Interface in bytes. 
Within this space no overlaps are permitted between the 
installed interfaces. 
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The ComPort information box informs you permanently about the serial line 
operation parameters. 

 ComPort ComPort information box contains 4 groups of 
serial line specific information: Port, Baud Rate, Parity and 
Stop Bits data. To find out more about this topic see the 
Serial Port Settings dialog.  
 

 



  

 

    http:\\www.brilan.com, http:\\www.softhill.com 

 

67 

REFERENCE SCENARIOS REFERENCE SCENARIOS REFERENCE SCENARIOS REFERENCE SCENARIOS –––– BRILAN  BRILAN  BRILAN  BRILAN 
ADVANTAGESADVANTAGESADVANTAGESADVANTAGES    

Motto:  
Your networks were never as Accessible, Powerful, and Secure. 
Network administration was never so Easy, Transparent, and Integrated. 
BriLAN = Networks build on the stable pillars of Connectivity, 
Performance and Security. 

 

1. The simplest BriLAN bridge 

2. BriLAN bridge with different media and link speed 

3. Improving wireless accessibility with BriLAN bridge 

4. The simplest BriLAN router 

5. Voice over data networks (analog phone through IP tunnels) Co
nn

ec
tiv

ity
 

6. Integration of Data and Voice with BriLAN (PBX+Data transfer) 

7. QoS management with BriLAN 

8. Traffic Shaping with BriLAN 

9. Lowering network load with BriLAN Broadcast Storm Protection 

10. Complex network setup and BriLAN Bandwidth Management 

Pe
rfo

rm
an

ce
 

11. Remote management, understanding BriLAN Network Events 

12. Securing networks with port grouping on BriLAN bridge 

13. Securing networks with MAC address filtering on BriLAN bridge 

14. Managing Network Nodes with Default Port Accessibility. 

15. Securing networks with IP address filtering on BriLAN router Se
cu

rit
y 

16. Using BriLAN firewall for advanced security of your networks 
 
For more information on listed reference scenarios please refer to BriLAN Training 
Kit.  
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APPENDIX A APPENDIX A APPENDIX A APPENDIX A ---- PRODUCT FEATURES PRODUCT FEATURES PRODUCT FEATURES PRODUCT FEATURES    

� 

This Appendix provides basic technical data on 
BriLAN NOS. 

The fully graphical network management 32-bit Windows software, BriLAN NMS, 
is capable of managing your BriLAN Network Devices from any networked PC 
over the Internet.  
 

BBBrrriiidddgggiiinnnggg   mmmeeettthhhoooddd   
• OSI Level 2 (Data Link) store and forward 
• up to 8 logical groups per port (VLAN) 
• packet filtering on MAC address level  

RRRooouuutttiiinnnggg   mmmeeettthhhoooddd   
• OSI Level 3 Network; static routing tables 
• up to 64 routing records per Device (128 optional) 
• packet filtering on IP address level  

VVVoooiiiccceee   fffeeeaaatttuuurrreeesss   
• Voice Activity Detection (VAD) 
• Comfort Noise Generation (CNG) 
• Acoustic Echo Cancellation (AEC) 
• True Speech G723.1 at 6.3, 5.3, 4.8 or 4.1 Kbps at 8 KHz 

sampling rate 
• Pass-through 8/16-bit linear modes at 8 KHz sampling rate 

MMMaaaxxxiiimmmuuummm   fffooorrrwwwaaarrrdddiiinnnggg   rrraaattteee   
• up to maximum Ethernet/FastEthernet speed (depending on the 

used hardware) 
• up to 22 Mbps radio 
• 64 independent traffic shaping queues per port 
• speed limit in range from 32 Kbps to 2048 Kbps 

PPPaaaccckkkeeettt   bbbuuuffffffeeerrr      
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•  3x512 Kbyte shared software data buffer  

AAAvvvaaaiiilllaaabbbllleee   IIInnnttteeerrrfffaaaccceeesss   aaannnddd   PPPooorrrtttsss   
Any combination of: 
• Ethernet Interfaces (Single or Multiport) 
• Fast Ethernet Interfaces (Single or Multiport) 
• Wireless Interfaces  
• Synchronous Interfaces (Single or Multiport) 
• Voice Interfaces (Analog phone line) 

SSStttaaannndddaaarrrddd   cccooommmpppllliiiaaannnccceee   
• IEEE 802.3   Ethernet 
• IEEE 802.3u FastEthernet 
• IEEE 802.1d Transparent learning bridge 
• IEEE 802.11(b) WLAN - Wireless network 
• ITU standards for Voice (Codecs G.729a and G.711) 
• H.323/H.324 industry standard Voice 

RRRooouuuttteeeddd   ppprrroootttooocccooolllsss   
• TCP/IP 
• Frame Relay 
• PPP 

WWWiiirrreeellleeessssss   fffeeeaaatttuuurrreeesss   
• point-to-point and point-to-multipoint  
• 2.4 and 5.8 GHz ISM band 
• speed up to 22 Mbps 
• distance up to 15 miles (22 kilometers) 

PPPooorrrttt   ssstttaaatttiiissstttiiicccsss   
• complete port traffic statistics   
• collection polling rate: 10 seconds 

AAAddddddrrreeessssss   tttaaabbbllleee   fffeeeaaatttuuurrreeesss   
• 2048 learned nodes per BriLAN Network Device 
• 10 min flushing time  

CCCooommmpppaaatttiiibbbiiillliiitttyyy   lll iiisssttt   ooofff   sssuuuppppppooorrrttteeeddd   IIInnnttteeerrrfffaaaccceeesss   
•   Ethernet interfaces  

� 3Com EtherLink III (3C509) 10Mbps, ISA adapter 
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� SMC Ultra and EtherEZ,  ISA adapter 
� NE2000 compatibles 10Mbps, ISA adapter 
� NE2000 compatibles 10/100Mbps, PCI adapter (with 

RTL8139 ethernet controller) 
 

•   Wireless interfaces 
� Aironet PC4500/PC4800 11Mbps, ISA/PCI adapter 
� Cisco/Aironet 340 Series 11Mbps, PCI adapter 
� Samsung WSL-2000P 11Mbps, PCI adapter 
� WaveLan Orinoco 11Mbps, ISA adapter  

•   Asynchronous interfaces 
� UART 16450/16550 series 

•   Synchronous interfaces 
� Moxa SuperSync C101, X.21/V.35 serial synchronous ISA 

adapter (up to 5Mbps) 
•   Voice interfaces  

� QuickNet Internet LineJACK, analog phone line ISA 
adapter 

SSSeeecccuuurrriiitttyyy   fffeeeaaatttuuurrreeesss   
• Password protected management  
• 64 bit software encryption 
• Encrypted proprietary management protocol 
• 64-bits BlowFish encrypted traffic  
• Additional hardware based encryption is available 
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APPENDIX B APPENDIX B APPENDIX B APPENDIX B ---- TERMINOLOGY TERMINOLOGY TERMINOLOGY TERMINOLOGY    

� 

This Appendix provides an explanation of 
terminology used in this Guide. 

 

���   BriLAN NOS – BriLAN Network Operating System 
is software which turns a common PC into a 
manageable network device with combined 
functionality: Bridge, Multiplexor, Router, Hub, 
Switch, Active Repeater, Access Point and Voice 
Gateway. This software, named BNOS, is installed on 
your BriLAN Network Device. 

���   BriLAN NMS – BriLAN Network Management 
System is the software used for remote management 
of BriLAN Network Devices. This software, named 
BNMS.EXE, should be installed on a PC with any 
32-bit Windows operating system. 

���   BriLAN Network Device – (the Device) a complete 
network device powered by BriLAN NOS including 
all hardware and software components. 

���   BriLAN Management Station – a PC running 
Windows operating system with the BriLAN NMS 
software installed. 

���   BriLAN Distribution Disk – a disk containing all 
BriLAN system files in shipping version. The BriLAN 
NOS X.Y.ZZ directory contains files necessary for 
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generating the BriLAN NOS on the BriLAN Bootable 
Medium, while the BriLAN NMS X.Y.ZZ directory 
includes installation files for the BriLAN NMS 
software. X.Y.ZZ denotes the current version of the 
shipped software. 

���   BriLAN Bootable Medium – contains the BriLAN 
NOS in executable version. 

���   Compatibility List – contains the list of all BriLAN 
supported hardware components. 

���   Interface – means any applicable hardware extension 
interface card listed in the Compatibility List. 

���   Interface Manufacturer – for more information on 
the Interface manufacturer see the Compatibility list  

���   Manufacturer's Interface Configuration Utility – 
software provided by the Interface manufacturer 
necessary to configure the Interface operation 
parameters within the hardware setup. 

���   Manufacturer's Interface Test Utility – software 
provided by the Interface manufacturer to test basic 
functionality of the particular setup. 
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INDEXINDEXINDEXINDEX    

Place the register here! 
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YOUR NOTES HERE: 
(This page is intentionally left blank) 
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